Thank you for purchasing an Oriental Motor product. This Operating Manual describes product handling procedures and safety precautions.

- Please read it thoroughly to ensure safe operation.
- Always keep the manual where it is readily available.

Support software

MEXE02

OPERATING MANUAL

This manual describes the MEXE02 Ver. 3.10 and later.
The screens and operation procedures in the MEXE02 Ver. 3.10 and later differ from those in versions earlier than the MEXE02 Ver. 3.10.
Please contact your nearest Oriental Motor branch or sales office for further information.
Table of contents

1  Introduction ........................................................................ 4
2  Safety precautions ............................................................ 7
3  Startup and shutdown ........................................................ 8
   3-1 Starting the MEXE02 ................................................... 8
   3-2 Shutting down ............................................................ 8
   3-3 Checking version information ...................................... 9
4  Connection with MEXE02 and applicable products ............. 10
   4-1 Connection with applicable product ............................. 10
   4-2 Setting of communication port .................................... 10
   4-3 Checking the connected product ................................. 10
5  Methods for creating new data and editing data .................. 12
   5-1 Creating new data ..................................................... 12
   5-2 Setting data in the data edit window ............................ 14
   5-3 Saving a data file ..................................................... 16
   5-4 Data initialization .................................................... 18
   5-5 Ending data edit ....................................................... 18
6  Communication function between MEXE02 and applicable products .................................................. 19
   6-1 Writing data to applicable product ............................... 19
   6-2 Reading data from applicable product ......................... 20
   6-3 Verifying data .......................................................... 21
   6-4 Resetting data of applicable product to factory default settings .................................................. 23
   6-5 Executing Configuration ............................................ 24
   6-6 Online/Offline .......................................................... 24
7  Printing data ...................................................................... 25
   7-1 How to print data ....................................................... 25
   7-2 Print preview ........................................................... 26
   7-3 Setting print options .................................................. 27
8  Setup function .................................................................. 29
   8-1 Editing operation data ............................................... 29
   8-2 Editing parameters .................................................... 30
   8-3 Teaching/remote operation ....................................... 31
   8-4 Remote operation ..................................................... 32
   8-5 I/O test .................................................................... 33
9  Monitor function ............................................................... 34
   9-1 Status, I/O monitor .................................................... 34
   9-2 I/O monitor ............................................................. 35
   9-3 Remote register monitor ........................................... 37
   9-4 RS-485 status monitor .............................................. 38
   9-5 Remote monitor ....................................................... 39
10 Adjustment functions ........................................................ 40
    10-1 Waveform monitor .................................................... 40
    10-2 Gain tuning ............................................................ 42
11 Diagnosis functions ........................................................ 44
    11-1 Alarm monitor ........................................................ 44
    11-2 Warning monitor .................................................... 45
    11-3 RS-485 communication monitor ............................... 46
12 Utilizing MEXE02 ............................................................ 47
    12-1 Operating motor using the MEXE02 ......................... 47
    12-2 Teaching software limit ........................................... 50
    12-3 Utilizing waveform monitor .................................... 51
    12-4 Checking wiring of applicable product ...................... 54
    12-5 Utilizing the warning function for when writing data ........................................................................ 55
    12-6 Updating the firmware of applicable product ............. 57
13 Troubleshooting ............................................................... 58
    13-1 Checking error message ............................................ 58
    13-2 Frequently encountered errors ................................. 59
License Agreement for Support software (MEXE02)

Please read the following terms and conditions carefully before using the Support software (MEXE02) ("Software"). The user of the Software ("User") shall be deemed to agree to those terms and conditions when the User makes the Software available for the use (including, but not limited to, download, installation and any similar action), and this license agreement shall be deemed to be entered into between ORIENTAL MOTOR CO., LTD. ("ORIENTAL MOTOR") and the User.

1. The ownership right, copyright and other intellectual property right, and all other rights with regard to the Software shall belong to either ORIENTAL MOTOR or its licensor, depending on the nature of each specific right.

2. ORIENTAL MOTOR shall grant to the User a non-exclusive right to use the Software only for the purpose of using an ORIENTAL MOTOR product or products supported by the Software.

3. The User may install and use one (1) copy of the Software in one (1) specific computer. If deemed necessary, one (1) backup copy of the Software may be created following installation.

4. The User may not reproduce, distribute, lend or transfer the Software to any third party or otherwise allow any third party to use the Software in any form or by any means. Furthermore, the User may not upload the Software to an electric bulletin board or website which is accessible by public.

5. The User may not modify, alter, reverse-engineer, decompile, disassemble or otherwise manipulate all or part of the Software.

6. The User shall observe the Foreign Exchange and Foreign Trade Law and other applicable laws and regulations related to export and import in Japan in using the Software. The User shall not export the Software to any country which is subject to the export control regulations by the government of Japan or USA.

7. Neither ORIENTAL MOTOR nor its licensor shall make any warranty as to whether the Software is appropriate or useful in serving a specific purpose of the User, whether the Software is free from defects, or any other condition relating to the Software.

8. Neither ORIENTAL MOTOR nor its licensor shall be held liable whatsoever for any loss or damage arising directly or indirectly in association with, or in relation to, a use of the Software, including, but not limited to, loss or damage arising from damage or corruption of hardware or software, loss of benefit, disruption of business, loss of any data.

9. Neither ORIENTAL MOTOR nor its licensor shall be held liable whatsoever for any claim or demand made by a third party regarding the Software.

10. ORIENTAL MOTOR shall reserve the right to change the specifications of the Software without prior notice for the purpose of improvement.

11. This Agreement shall be terminated immediately upon the User's violation of this Agreement. The User may not use the Software once this Agreement is terminated.

12. This Agreement shall be executed in both Japanese and English language, and in the event of any conflicting terms, the Japanese version shall prevail.

13. This Agreement shall be governed by and interpreted in accordance with the Laws of Japan.

14. If any dispute arises out of this Agreement, the Tokyo District Court shall have exclusive jurisdiction to settle such dispute for the first instance.
Introduction

This manual describes the MEXE02 Ver. 3.10 and later. The screens and operation procedures in the MEXE02 Ver. 3.10 and later differ from those in versions earlier than the MEXE02 Ver. 3.10. Please contact your nearest Oriental Motor branch or sales office for further information.

Before Use
Perform any installation, uninstallation, editing, and other operations for the support software MEXE02 using an account with Administrator privileges.
Use the MEXE02 correctly and safely after thoroughly reading the manual and understanding the basic operating procedures and other details.

Applicable product
The MEXE02 can be used with Oriental Motor’s stepping motor drivers, servo motor drivers, brushless motor drivers, and network converters etc.
A product that can be combined with the MEXE02 is described as “applicable product” here.

Notation rules
The description of text in this manual follows the notation rules specified as shown at the right. The screens shown in this manual are those displayed in Windows 7. The screens vary according to the operating systems (OS) you will be using.

Menus and submenus shown in/from the title bar, buttons, and other controls that can be clicked with the mouse, are enclosed in square brackets.
Dialog box messages, etc., are enclosed in double quotations marks.

Unless otherwise noted, this manual explains using screen examples of the AR Series FLEX AC power input Built-in controller type.

Functions of MEXE02
The MEXE02 is a software program that lets you set data required for motor operation from a PC. Data can be edited in various PC screens, or data set in an applicable product can be checked from a PC.
The key functions of the MEXE02 are explained below.

Functions, setting items, screens and others vary depending on the applicable product combined with the MEXE02. For the functions and operating methods that can be used, check the USER MANUAL or AZ Series Function Edition of the applicable product.

- Editing and saving the data
Operation data and parameters can be created and edited.
Data edited in the MEXE02 can be written to an applicable product, or data stored in an applicable product can be read into the MEXE02.
You can save data files created in the MEXE02 in either the MEXE02's dedicated file format or CSV format.

- Monitor function
You can monitor the product (motor and driver) status, motor operating status, ON/OFF status of I/O signals, and others.
The waveform monitor lets you check I/O signals, motor speeds and other settings based on measured waveforms.

- Test function
  - I/O test can be performed to monitor input signals and cause output signals to be output forcibly.
  - Test operation for the motor can be performed using the teaching/remote operation or remote operation.
Support menu

The [Support] menu may be shown on the menu bar depending on the applicable product combined with the MEXE02. The update of firmware can be performed from the [Support] menu.

- The [Support] menu is not shown for all of the applicable products.
- The contents of the [Support] menu vary depending on the applicable product.

Installation and uninstallation of MEXE02

For the installation and uninstallation of the MEXE02, refer to Oriental Motor Website or the separate manual "Support software MEXE02 INSTALLATION MANUAL."

Communication cables

Communication cables vary depending on the applicable product. Check the USER MANUAL or OPERATING MANUAL Driver of the applicable product.

- When using a USB cable
  Use a commercially available USB cable.

- When using the CC05IF-USB communication cable for the support software
  The CC05IF-USB supplied communication cable for the support software consists of a pair of cables, PC interface cable and USB cable. Provide it separately. (as an accessory).

General specifications of CC05IF-USB

<table>
<thead>
<tr>
<th>Interface</th>
<th>USB Specification 1.1 (Full Speed 12 Mbps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector shapes</td>
<td>RS-485 (Mini DIN 8 Pin: male), USB (Type Mini B: female) USB Type A connection via included USB cable to connect to a PC</td>
</tr>
<tr>
<td>Communication system</td>
<td>Half duplex</td>
</tr>
<tr>
<td>Communication speed</td>
<td>9600 bps</td>
</tr>
<tr>
<td>Indicator</td>
<td>The LED is lit (green) when recognized by PC and ready to use.</td>
</tr>
<tr>
<td>Power supply</td>
<td>USB bus power</td>
</tr>
<tr>
<td>Current consumption</td>
<td>25 mA (100 mA max.)</td>
</tr>
<tr>
<td>Dimension</td>
<td>25×58.6×16 mm (0.98×2.31×0.63 in.) [excluding cable section]</td>
</tr>
<tr>
<td>Mass</td>
<td>PC interface cable: App. 0.2 kg (7.1 oz) USB cable: App. 0.03 kg (1.06 oz)</td>
</tr>
<tr>
<td>Operating environment</td>
<td>Ambient temperature: 0 to +40 °C (+32 to +104 °F) (non-freezing) Ambient humidity: 85% or less (non-condensing) Atmosphere: No corrosive gas, dust, water or oil</td>
</tr>
<tr>
<td>Insulation system</td>
<td>Non-isolated</td>
</tr>
</tbody>
</table>
Introduction

**System requirements**

The installation of the MEXE02 on a PC requires one of the following operating systems (OS) and a PC compatible with the OS you will be using.

**PC**

<table>
<thead>
<tr>
<th>Required Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended CPU *1</td>
<td>Intel Core processor 2 GHz or higher (Your operating system must support the OS.)</td>
</tr>
<tr>
<td>Display</td>
<td>Video adapter or monitor of XGA (1024x768) or higher resolution</td>
</tr>
</tbody>
</table>
| Recommended memory *1             | 32-bit (x86) version: 1 GB or more
                                        | 64-bit (x64) version: 2 GB or more |
| Hard disk *2                      | Available disk space of 60 MB or more      |
| USB port                          | Using USB cable: One USB2.0 port
                                        | Using CC05IF-USB: One USB1.1 port      |

*1 The hardware requirements for the OS must be satisfied.

*2 Microsoft .NET Framework 4 Client Profile must be installed in your PC for the MEXE02 to function. It will be installed automatically, if not already installed. Accordingly, additional free hard disk space shown below may be required.

32-bit (x86) version: 600 MB
64-bit (x64) version: 1.5 GB

---

**Operating System (OS)**

Both the 32-bit (x86) and 64-bit (x64) versions are supported.
- Microsoft Windows 10
- Microsoft Windows 8.1
- Microsoft Windows 8
- Microsoft Windows 7 Service Pack 1
- Microsoft Windows Vista Service Pack 2 *
- Microsoft Windows XP Service Pack 3 [Service Pack 2 for 64-bit (x64) version]

* If the root certificate is not the latest one, you may fail to install the MEXE02.

---

**RoHS Directive**

The products do not contain the substances exceeding the restriction values of RoHS Directive (2011/65/EU).
2 Safety precautions

The MEXE02 is designed with the assumption that the user has an understanding of basic operations such as starting up and exiting applications and how to use a mouse in Windows XP, Windows Vista, Windows 7, Windows 8, Windows 8.1 and Windows 10. Use the product only after carefully reading and fully understanding these instructions. Also read the “Safety precautions” section in the USER MANUAL or OPERATING MANUAL Driver for the product to be used in combination with the MEXE02.

⚠️ Warning

Handling the product without observing the instructions that accompany a "Warning" symbol may result in serious injury or death.

Connection

- Turn off the power to both the PC and applicable product before connecting your PC to the applicable product. Failure to follow this instruction may cause electric shock.

⚠️ Caution

Handling the product without observing the instructions that accompany a "Caution" symbol may result in injury or property damage.

Connection

- The data setter connector or USB connector of the applicable product is not insulated. When grounding the positive terminal of the power supply, do not connect any equipment (PC, etc.) whose negative terminal is grounded. Doing so may cause the equipment and applicable product to short, damaging both. Do not ground the equipment if you plan to connect it.

Disposal

- Dispose the product correctly in accordance with laws and regulations, or instructions of local governments.
3 Startup and shutdown

This chapter explains how to start up and shut down the MEXE02.

3-1 Starting the MEXE02

Double-click the MEXE02 icon on the desktop to start the MEXE02. Once the MEXE02 has started, the following window appears.

3-2 Shutting down

Click [Exit] from the [File] menu. Alternatively, click the button on the upper right of the screen. The MEXE02 shuts down.
3-3 Checking version information

You can check the version of the MEXE02 software you are using.

1. Click [About MEXE02] from the [Help] menu.

2. After you have checked the software version, click [Close].
This chapter explains how to prepare to start communication with the MEXE02, and how to check the connected product.

### 4-1 Connection with applicable product

1. Connect the PC on which the MEXE02 has been installed and an applicable product. Read the USER MANUAL or OPERATING MANUAL Driver of the applicable product to connect it correctly. Refer to p.5 for the communication cable.

2. Turn on the power to the applicable product.

### 4-2 Setting of communication port

When connecting the PC and applicable product, the communication port is required to set.

1. Click [Setting of the communication] from the [Communication] menu.

2. Select the port to which the applicable product is connected and click [OK].
   - When connecting using the USB cable: “ORIENTAL MOTOR/common virtual COM port” is displayed.
   - When connecting using the CC05IF-USB: “ORIENTAL MOTOR/virtual COM port” is displayed.

**Note** Before setting the communication port, make sure to connect the PC and applicable product and turn on the power of the applicable product. Without proper connection, the connection port will not be displayed.

### 4-3 Checking the connected product

1. Click [Device information] from the [Tool] menu.

2. Click [Check]. The check on the connected product starts.
3. When the results are displayed, click [Close].

- **When the series name or product name (mode) of the applicable product is not displayed.**
  Verify the following points:
  - Is the applicable product powered on?
  - Is the cable completely inserted?
  - Is the connected product compatible with the MEXE02?

- **When "Unsupported product" is shown in the product name column.**
  Verify that the connected product is compatible with the MEXE02.
This chapter explains how to create data files, edit operation data and parameters, and store edited data.

5-1 Creating new data

1. Click the [New] icon in the toolbar.

2. Select the model with any of the following methods.
   ① Click [Search model].
   The connected product is automatically selected.
   ② Select the model from the "Product series list," "Product name (mode) list," and "Motor/actuator."
   This is a method to select the model manually from the products shown in the list.
   ③ Select the model from "Selection log."
   This is a method to select the model manually from "Selection log."

3. Click [OK].
   The data edit window appears.

Memo: In the case of actuators, select the series name of the motor that is equipped to the actuator.
Methods for creating new data and editing data

Description of edit window

1. Menu bar
   This is used to select and execute a function.

2. Tool bar
   Some of the functions available on the menu are provided as an array of icons.

3. Tree view
   This is used to select a group of data for editing.

4. Short-cut buttons
   Using these buttons, functions such as monitor and test can be executed. The functions in this area can also be executed from the [Tool] menu.

5. Data setting area
   This is an area to edit data. The display is changed by selecting a group from the tree view.

Explanation of functions

Functions, setting items, screens and others vary depending on the applicable product combined with the MEXE02. For the functions and operating methods that can be used, check the USER MANUAL or AZ Series Function Edition of the applicable product.

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teaching remote operation</td>
<td>![Teaching Icon]</td>
<td>This function lets you check how the motor will operate before actually connecting it to a master controller. Operation data can also be set using teaching function.</td>
</tr>
<tr>
<td>Remote operation</td>
<td>![Remote Icon]</td>
<td>This function lets you check how the motor will operate before actually connecting it to a master controller.</td>
</tr>
<tr>
<td>I/O test</td>
<td>![I/O Icon]</td>
<td>I/O signals of direct I/O and remote I/O can be tested. Also, you can monitor input signals and cause output signals to be output forcibly. This function is convenient if you want to check the wire connection of physical I/O with the master controller and the operation of network I/O.</td>
</tr>
<tr>
<td>Status, I/O monitor</td>
<td>![Status Icon]</td>
<td>You can monitor the current status of an applicable product and the ON/OFF status of I/O signals.</td>
</tr>
<tr>
<td>Internal I/O monitor</td>
<td>![Internal Icon]</td>
<td>All the I/O signals of an applicable product can be monitored. You can also check signals not assigned to direct I/O or remote I/O.</td>
</tr>
<tr>
<td>Remote I/O monitor</td>
<td>![Remote Icon]</td>
<td>You can check the ON/OFF status of network I/O.</td>
</tr>
<tr>
<td>Remote register monitor</td>
<td>![Register Icon]</td>
<td>You can monitor the remote register status that can be read and written to via a network.</td>
</tr>
</tbody>
</table>
Methods for creating new data and editing data

<table>
<thead>
<tr>
<th>Name</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-485 status monitor</td>
<td>🏡</td>
<td>You can monitor the RS-485 communication status of an applicable product.</td>
</tr>
<tr>
<td>Remote monitor</td>
<td>🗃</td>
<td>You can monitor the data sent and received between an applicable product and master controller.</td>
</tr>
<tr>
<td>Alarm monitor</td>
<td>🗃</td>
<td>The alarm records of up to ten most recent alarms starting from the latest one can be checked. Also, with the AZ Series, the operation and the status of I/O signals, which were executed when the alarm generated, can be checked.</td>
</tr>
<tr>
<td>Warning monitor</td>
<td>🗃</td>
<td>The warning records of up to ten most recent warnings starting from the latest one can be checked.</td>
</tr>
<tr>
<td>RS-485 communication monitor</td>
<td>🏡</td>
<td>The error records of up to ten most recent errors starting from the latest one can be checked. Also, with the AZ Series, the received data via RS-485 communication can be checked.</td>
</tr>
<tr>
<td>Waveform monitor</td>
<td>🏡</td>
<td>The motor speeds and I/O signal status can be checked in waveforms.</td>
</tr>
<tr>
<td>Gain tuning</td>
<td>🏡</td>
<td>You can adjust parameters while checking the motor speeds and I/O signal status in waveforms.</td>
</tr>
</tbody>
</table>

5-2 Setting data in the data edit window

Note: Just changing the data in the MEXE02 will not cause the data in the applicable product to change. To change the data in the applicable product, writing data must be performed. Refer to p.19 for details.

Memo: Data cannot be edited while communicating with the applicable product using the monitor or test function. Edit data after ending the communication.

■ Opening an existing data file

1. Click the [Open] icon in the toolbar.

2. Select the file you want to edit, and click [Open]. The data edit window appears.
Methods for creating new data and editing data

- Data entry
  The background color of a cell is initially white. When the value in the cell is changed, the color of the cell changes to yellow.
  The color of characters in the cell is initially blue. When the value in the cell is changed, the color of characters changes to black.

- Entering a numeric value
  Click a desired cell, and enter a numeric value using the keyboard.

- Selecting a value from a pull-down menu
  Double-clicking a desired cell displays a pull-down menu.
  Select a desired value from the pull-down menu.

- Entering characters
  Click a cell and enter characters using the keyboard.

Note
Do not enter a comma (,) in the "Name" field of the operation data. Entering a comma may cause a problem in the subsequent data edit.

- Copying and pasting data
  You can copy an entered value and paste it into a different cell. Copying and pasting lets you quickly populate multiple cells with the same value.

1. Select the data you want to copy, and then click the [Copy] icon in the toolbar.
   You can select a single value or multiple values.

   ![Data to be copied](image1)

2. Click the cell you want to paste the data into, and then click the [Paste] icon in the toolbar.

   ![Destination cell](image2)
Methods for creating new data and editing data

- **Undoing and redoing**

  1. To undo the last edit that you made, click the [Undo] icon in the toolbar.

  2. To redo the last edit that was undone, click the [Redo] icon in the toolbar.

  - [Undo] operation cannot execute:
    - When communicating with the applicable product
    - When no edit has been done yet.
  - [Redo] operation cannot execute:
    - When no [Undo] has been done yet.

---

5-3 **Saving a data file**

The data edited within the MEXE02 or data read by the applicable product will be saved as a file. Data files can be saved in the MEXE02 format (.mx2), MEXE02 extended format (.mx2a), or CSV format (.csv). Data files saved in the MEXE02 format and MEXE02 extended format cannot be opened in other applications. Save data files in the CSV format if you want to open them in other applications.

- **Saving data by overwriting**

  Click the [Save] icon in the toolbar.
  The current data is saved over the existing data.

- **Saving data under a different name**

  1. Click [Save as] from the [File] menu.

  2. Enter a new file name, and click [Save].
  The data is saved under the specified name.
Methods for creating new data and editing data

If the data, which has been saved in the MEXE02 extended format (.mx2a), will be saved in the MEXE02 format (.mx2) again, the extended information will be erased. Be sure to check the saving format (filename extension) beforehand.

![Image of file type options]

**Saving data in CSV format**

Data saved in the CSV format can be edited in applications other than the MEXE02.

Data files in the CSV format cannot be opened in the MEXE02. To edit in the MEXE02, open the file in an application other than the MEXE02, and paste the data to the MEXE02.


![Image of export options]

2. Enter a file name, and click [Save].

   All operation data and parameters are saved in CSV format.
5-4 Data initialization

- **Restoring the editing data to the default**
  You can initialize the data you have edited in the data edit window.

1. Click [Initialize] from the [Edit] menu.

   ![Initialize menu](image)

2. Select the data you want to initialize, and click [OK].

   ![Warning dialog](image)

3. Click [Yes].
   The data being edited is returned to the default.

- **Restoring only the value in the selected cell to the default**

1. Select the cell to return to the default on the data edit window.

2. Click the right mouse button, and click [Initialize].
   The value in the selected cell returns to the default.
   The color of the cell remains as yellow. It does not return to white (initial state).

5-5 Ending data edit

To close the data edit window, click [Close] from the [File] menu.
6 Communication function between MEXE02 and applicable products

This chapter explains how to hold communication between the MEXE02 and an applicable product to write or read data.

6-1 Writing data to applicable product

The data created in the MEXE02 can be written to the applicable product.

Do not turn off the power of the applicable product while writing data. Doing so may destroy the data.

1. Click the [Data writing] icon in the toolbar.

2. Select data to be written and click [OK].

3. Click [Yes].
   Data writing starts.

4. If the following message is displayed, click either [Yes] or [No] after checking the applicable product.
   [Yes]: Writing data will be started.
   [No]: Writing data will be discontinued.

5. After it is completed, click [OK].

Depending on the data, you may need to turn off and on the power or execute Configuration. Follow the instructions in the displayed messages.

- Restarting power
- Executing Configuration
  Click [Yes] to execute Configuration. If you click [No], execute Configuration manually. Refer to p.24 for details.
6-2  Reading data from applicable product

The data saved in an applicable product can be read to the MEXE02.

1. Click the [Data reading] icon in the toolbar.

2. If the data is being edited in the MEXE02, a confirmation message for saving the data is shown.
   Click [Yes] to save the edited data or [No] not to save it.

   If you select [No], the data under editing is cleared and overwritten with the data to be read.

3. Click [OK].
   Data reading starts.

4. After it is completed, click [OK].
   The screen shows the data that has been read.
6-3 Verifying data

The data saved in the applicable product can be verified against the data displayed in the MEXE02.

1. Click the [Data verification] icon in the toolbar.

2. Select the data to be verified, and then click [OK].
   Data is verified.
   The results are displayed after the completion of verification.

3. After checking the verification results, click [Close].

■ Copying verification results

The verification results can be copied to the clipboard by clicking the right mouse button on the area that displays the results and clicking [Copy results to clipboard]. The copied data can be pasted to other applications.

Nothing is copied if the data completely matches.
Jumping to desired data from verification results
You can jump from the list of verification results to the edit window for the displayed data.

1. Select and double-click data that you want to edit. The window for editing the desired data appears.

2. Click [Close].
6-4 Resetting data of applicable product to factory default settings

The data saved in the non-volatile memory of the applicable product can be reset to the factory default settings.

**Note** Do not turn off the power of the applicable product until the process is complete. Doing so may destroy the data.

1. Click [Reset] from the [Communication] menu.

2. Select data that you want to reset to the factory default settings and click [OK].

3. Click [Yes]. The data saved in the non-volatile memory of the applicable product will be reset to the factory default settings.

4. After it is completed, click [OK].

**Memo** Depending on the data, you may need to turn off and on the power or execute Configuration. Follow the instructions in the displayed messages.

- **Restarting power**
- **Executing Configuration**
  Click [Yes] to execute Configuration. If you click [No], execute Configuration manually. Refer to p.24 for details.
6-5 Executing Configuration

When the data of an applicable product is changed, the timing that the new value is applied varies depending on the data. When a message prompts asking to execute Configuration, perform according to the following procedure. This section explains using screen examples of the AZ Series Pulse input type and Built-in controller type.

1. Click [Configuration] from the [Communication] menu.

2. Click [Yes]. Configuration is executed.

3. After it is completed, click [OK].

6-6 Online/Offline

This section explains how to switch between connection (online) and disconnection (offline) for a PC and applicable product.

1. Click the [Online] icon in the toolbar. The [Online] icon is depressed and the PC and applicable product are connected (online).

2. To clear the connection, click the [Offline] icon.

- When the monitor function or test function is executed, the PC and applicable product are automatically connected (online).
- Clicking the [Offline] icon stops the monitor function or test function that is conducting communication.
7 Printing data

This chapter explains how to print the set data and waveform measurement results.

7-1 How to print data

1. Click [Print] from the [File] menu.

2. Set the print item, print object and color, and click [Run].

3. At "Name," select a printer that you want to use for printing and click [OK]. Data is printed.
7-2 Print preview

You can preview the print image on screen before printing it on the printer.


When [Print] is clicked

The print preview window appears.

2. After checking the print image, click [Close].
7-3 Setting print options


2. Click the tab of an option that you want to set. After the setting is completed, click [OK].

- **"Page" tab**
  Set the orientation, paper, etc. to be used for printing.

- **"Margin" tab**
  Set the paper margin and header/footer positions.
Printing data

- "Header/footer" tab
  Set the header/footer.
This chapter explains the functions mainly used to start up an applicable product.

### 8-1 Editing operation data

The operation data of an applicable product can be edited using the **MEXEO2**.

**Note** Just changing the data in the **MEXEO2** will not cause the data in the applicable product to change. To change the data in the applicable product, writing data must be performed. Refer to p.19 for details.

1. Open the data edit window.
2. Click [Operation data] on the tree view. The operation data edit window appears.

Refer to "5-2 Setting data in the data edit window" on p.14 for how to edit data and other information.

**memo** When the **ARL** Series is used, set the product ID in "axis selection" before editing the operation data. To edit the data, the product ID and the ID selected in the axis selection of the **MEXEO2** must be matched.
8-2 Editing parameters

The parameters of an applicable product can be edited using the MEXE02. If "Data writing" is executed, the edited data can be written to the applicable product. Refer to "6-1 Writing data to applicable product" on p.19 for details.

1. Open the data edit window.

2. Click a parameter group that you want to edit from the tree view. The parameter edit window appears.

Refer to "5-2 Setting data in the data edit window" on p.14 for how to edit data and other information.
8-3 Teaching/remote operation

A motor can be operated using the MEXE02. This function lets you check how the motor will operate before actually connecting it to a master controller. Operation data can also be set using teaching function. Refer to p.47 for details.

**memo:** The teaching/remote operation and I/O test cannot be executed simultaneously.

1. Click the [Teaching, remote operation] icon in the toolbar or click the [Teaching, remote operation] short-cut button. The teaching/remote operation window appears.

2. Click “Start the teaching remote operation.”

3. Click [Yes]. The teaching/remote operation is enabled.

The teaching/remote operation requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

**memo:** When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

4. To end the teaching/remote operation, unselect “Start the teaching remote operation.”
Remote operation

A motor can be operated using the MEXE02. This function lets you check how the motor will operate before actually connecting it to a master controller. Refer to p.47 for details.

This section explains using screen examples of the AR Series AC power input Pulse input type.

**memo** The remote operation and I/O test cannot be executed simultaneously.

1. Click the [Remote operation] icon in the toolbar or click the [Remote operation] short-cut button. The remote operation window appears.

2. Click "Start the remote operation."

3. Click [Yes]. The remote operation is enabled.

The remote operation requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

**memo** When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

4. To end the remote operation, unselect "Start the remote operation."
8-5 I/O test

I/O signals of direct I/O and remote I/O can be tested. Also, you can monitor input signals and cause output signals to be output forcibly. This function is convenient if you want to check the wire connection of physical I/O with the master controller and the operation of network I/O.

Note

In I/O test, you can forcibly turn on or off output signals. Consequently, other equipment connected to an applicable product may operate. Check the surrounding circumstances to ensure safety before conducting this procedure.

memo

The teaching/remote operation and I/O test cannot be executed simultaneously.

1. Click the [Test I/O] icon in the toolbar or click the [Test I/O] icon.
   The I/O test window appears.

2. Click "Start I/O test."

3. Click [Yes].
   You can now perform I/O test.

4. Switch the ON/OFF status of input signals externally.
   The check box of the corresponding "INPUT" is changed in the window.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direct I/O</th>
<th>Remote I/O (RS-485 communication)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON (green)</td>
<td>Conducting</td>
<td>Active</td>
</tr>
<tr>
<td>OFF (white)</td>
<td>Non-conducting</td>
<td>Not active</td>
</tr>
</tbody>
</table>

5. When switching the ON/OFF status of output signals, click the check box of "OUTPUT" in the window.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direct I/O</th>
<th>Remote I/O (RS-485 communication)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON (green)</td>
<td>Conducting</td>
<td>Active</td>
</tr>
<tr>
<td>OFF (white)</td>
<td>Non-conducting</td>
<td>Not active</td>
</tr>
</tbody>
</table>

6. To end the I/O test, unselect “Start I/O test.”
This chapter explains how to check the status of an applicable product using the MEXE02.

9-1 Status, I/O monitor

You can monitor the current status of an applicable product and the ON/OFF status of I/O signals.

1. Click the [Status, I/O monitor] icon in the toolbar or click the [Status, I/O monitor] shortcut button.
   The status, I/O monitor window appears.

2. Click “Start the status, I/O monitor.”
   The status, I/O monitor starts.
   The ON/OFF status of I/O signals is displayed as shown below.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>I/O</th>
<th>RS-485 communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON (green)</td>
<td>Conducting</td>
<td>Active</td>
</tr>
<tr>
<td>OFF (white)</td>
<td>Non-conducting</td>
<td>Not active</td>
</tr>
</tbody>
</table>

The status, I/O monitor requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect “Start the status, I/O monitor.”
9-2  I/O monitor

■ Internal I/O monitor

All the I/O signals of an applicable product can be monitored. You can also check signals not assigned to direct I/O or remote I/O.

1. Click the [Internal I/O monitor] icon in the toolbar or click the [Internal I/O monitor] short-cut button. The internal I/O monitor window appears.

2. Click "Start the internal I/O monitor." The internal I/O monitor starts. The ON/OFF status of I/O signals is displayed as shown below.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Internal signal status</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON (green)</td>
<td>Active</td>
</tr>
<tr>
<td>OFF (white)</td>
<td>Not active</td>
</tr>
</tbody>
</table>

3. To exit the monitor, unselect "Start the internal I/O monitor."
Monitor function

### Remote I/O monitor

You can check the ON/OFF status of network I/O.
This section explains using screen examples of the network converter CC-Link compatible **NETC01-CC**.

1. Click the [Remote I/O monitor] icon in the toolbar or click the [Remote I/O monitor] short-cut button.
The remote I/O monitor window appears.

2. Click "Start remote I/O monitor."
The remote I/O monitor starts.
The ON/OFF status of I/O signals is displayed as shown below.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Remote I/O (RS-485 communication)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON (green)</td>
<td>Active</td>
</tr>
<tr>
<td>OFF (white)</td>
<td>Not active</td>
</tr>
</tbody>
</table>

The remote I/O monitor requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

![Synchronization Method Window]

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect "Start remote I/O monitor."

![Remote I/O Monitor Window]
9-3 Remote register monitor

You can monitor the remote register status that can be read and written to via a network. This section explains using screen examples of the network converter CC-Link compatible NETC01-CC.

1. Click the [Remote register monitor] icon in the toolbar or click the [Remote register monitor] short-cut button. The remote register monitor window appears.

2. Click "Start remote register monitor." The remote register monitor starts.

The remote register monitor requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect "Start remote register monitor."
9-4  RS-485 status monitor

You can monitor the RS-485 communication status of an applicable product. This section explains using screen examples of the network converter CC-Link compatible NETC01-CC.

1. Click the [RS-485 status monitor] icon in the toolbar or click the [RS-485 status monitor] short-cut button. The RS-485 status monitor window appears.


The RS-485 status monitor requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect “Start RS-485 status monitor.”
9-5 Remote monitor

You can monitor the data sent and received between an applicable product and master controller. This section explains using screen examples of the network converter EtherCAT compatible NETC01-ECT.

1. Click the [Remote monitor] icon in the toolbar or click the [Remote monitor] shortcut button.
   The remote monitor window appears.

2. Click “Start remote monitor.”
   The remote monitor starts.

   The remote monitor requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

   ![Synchronization Method window]

   When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect “Start remote monitor.”
This chapter explains how to adjust an applicable product using the MEXE02.

10-1 Waveform monitor

The motor speeds and I/O signal status can be checked in waveforms. Refer to p.51 for how to use the waveform monitor.

1. Click the [Waveform monitor] icon in the toolbar or click the [Waveform monitor] short-cut button. The waveform monitor window appears.

2. Click “Start waveform monitor.” The buttons in the window are enabled, allowing you to prepare for measurement of the waveform monitor.

1 Measurement results are drawn in this area.
2 The measurement conditions for each CH can be set. Refer to Step 3 for details.
3 Waveform measurement settings: Pos (trigger position), Level, CH, Mode, and Edge (detection condition) can be specified. For “CH,” only those CHs displayed at 1 can be specified.
4 Run: This button is used to start measurement. Stop: This button is used to stop measurement.
5 The measurement time range can be set.
6 The display method for CH3 and CH4 can be set. Scale: The display size can be selected from 1/1 (100%), 1/2 (50%), or 1/4 (25%). Signal name: The signal name can be shown or hidden.
7 The measure for measurement can be shown or hidden. Also, the CH to be measured can be selected.
8. The method to move the display position of the waveform drawn on the window can be selected. There are the following two moving methods.
   • Move the waveform per CH.
   • Move the waveform of the CH selected simultaneously.

9. The currently displayed waveform can be copied to the clipboard.

10. The currently displayed waveform can be saved to an external file. Refer to p.53 for details.

11. The setting for measurement can be loaded from "Favorites data." Refer to p.53 for details.

12. The setting for measurement can be saved as "Favorites data."

The waveform monitor may synchronize the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. Set the measurement conditions for each CH.

   1. Each CH can be shown or hidden.
   2. The display position of a waveform can be moved up or down.
   3. The display of measured signal can be inverted.
   4. Selecting this check box can drag displayed waveforms drawn in the window simultaneously.
   5. This is used to select a signal to be measured.
   6. This is used to select a display scale for signals (CH1 and CH2 only). Using this setting in combination with 7 can zoom in on signals.
   7. The set offset value is added to the signal display (CH1 and CH2 only). Using this setting in combination with 6 can zoom in on signals.

4. Click [Run].

The waveform measurement starts.

5. During measurement, click [Stop] to exit the waveform measurement.

If "SINGLE" is selected for Mode in Trigger, measurement automatically ends when waveform drawing ends.

6. To exit the waveform measurement, unselect "Start waveform monitor."
You can adjust parameters while checking the motor speeds and I/O signal status in waveforms.

1. Click the [Gain tuning] icon in the toolbar or click the [Gain tuning] short-cut button. The gain tuning window appears.

2. Click "Start gain tuning." The buttons in the window are enabled, allowing you to prepare for measurement of gain tuning.

- Waveform measurement settings: Level, CH, Mode, Edge (detection condition), and Pos (trigger position) can be specified. For "CH," only those CHs displayed can be specified.
- Run: This button is used to start measurement. Stop: This button is used to stop measurement.
- The measurement time range can be set.
- The display method for CH3 and CH4 can be set. Scale: The display size can be selected from 1/1 (100%), 1/2 (50%), or 1/4 (25%). Signal name: The signal name can be shown or hidden.
- The measure for measurement can be shown or hidden. Also, the CH to be measured can be selected.
- The display positions of waveforms drawn in the window can be moved. Normally, CHs selected are moved. Clicking can move all the CHs simultaneously.
- Measurement results are drawn in this area.
- The settings of gain tuning can be specified.
- The measurement conditions for each CH can be set.
- The currently displayed waveform can be copied to the clipboard.
- The currently displayed waveform can be saved to an external file. Refer to p.54 for details.
- The setting for measurement can be loaded from "Favorites data." Refer to p.53 for details.
- The setting for measurement can be saved as "Favorites data."
The gain tuning requires synchronization of the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. Click the “CH setting” tab.
   The measurement conditions for each CH can be set.

   1 Each CH can be shown or hidden.
   2 The display position of a waveform can be moved up or down.
   3 The display of measured signal can be inverted.
   4 Selecting this check box can drag displayed waveforms drawn in the window simultaneously.
   5 This is used to select a signal to be measured.
   6 This is used to select a display scale for signals (CH1 and CH2 only). Using this setting in combination with 7 can zoom in on signals.
   7 The set offset value is added to the signal display (CH1 and CH2 only). Using this setting in combination with 6 can zoom in on signals.

4. Click [Run].
   The waveform measurement starts.

5. During measurement, click [Stop] to exit the waveform measurement.
   If “SINGLE” is selected for Mode in Trigger, measurement automatically ends when waveform drawing ends.

6. To exit the waveform measurement, unselect “Start gain tuning.”
11 Diagnosis functions

Using the alarm monitor and the warning monitor, you can check the causes of errors and troubles of an applicable product.

11-1 Alarm monitor

The alarm records of up to ten most recent alarms starting from the latest one can be checked. Also, with the AZ Series, the operation and the status of I/O signals, which were executed when the alarm generated, can be checked.

1. Click the [Alarm monitor] icon in the toolbar or click the [Alarm monitor] short-cut button.
   The alarm monitor window appears.
2. Click "Start the alarm monitor."
   The alarm monitor starts.
   The current alarm and past alarm records are displayed. Click the displayed alarm to show the cause and measure for it.

The alarm monitor may synchronize the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect "Start the alarm monitor."
11-2  Warning monitor

The warning records of up to ten most recent warnings starting from the latest one can be checked.

1. Click the [Warning monitor] icon in the toolbar or click the [Warning monitor] short-cut button. The warning monitor window appears.

2. Click "Start the warning monitor.”
   The warning monitor starts.
   The current warning and past warning records are displayed. Click the displayed warning to show the cause and measure for it.

   The warning monitor may synchronize the data under editing and the data of an applicable product. When the data is not synchronized, the following window appears. Select a synchronization method and click [OK].

   When the above window appears, all the communications in progress are disabled. All the other monitors in progress in other windows are also stopped. Resume monitor after synchronization is completed.

3. To exit the monitor, unselect "Start the warning monitor.”
11-3 RS-485 communication monitor

The error records of up to ten most recent errors starting from the latest one can be checked. Also, with the AZ Series, the received data via RS-485 communication can be checked.

1. Click the [RS-485 com. monitor] icon in the toolbar or click the [RS-485 com. monitor] shortcut button. The RS-485 communication monitor window appears.

2. Click "Start the RS-485 communication." The RS-485 communication monitor starts. The current communication error and past communication error records are displayed. Click the displayed communication error to show the cause and measure for it.

3. To exit the monitor, unselect "Start the RS-485 communication."
12 Utilizing MEXE02

This chapter provides some examples of utilizing the MEXE02.

12-1 Operating motor using the MEXE02

A motor can be operated using the MEXE02. This function lets you check how the motor will operate before actually connecting it to a master controller. Operation data can be set using teaching function. Although there is no need to connect to a master controller, the applicable product must be connected to the power supply. Use the teaching/remote operation. The teaching/remote operation allows you to perform the following operations.

- Positioning operation
- Return-to-home operation
- ZHOME operation
- JOG operation
- Teaching

\[\text{memo}\]
- The teaching/remote operation and I/O test cannot be executed simultaneously.
- Before performing this operation, set necessary data and write it to an applicable product.
- When the operation is started, connect the power supply to the applicable product and enable the “teaching, remote operation.” Refer to p.31 for details.

■ Positioning operation

You can operate the motor using the operation data written to the applicable product.

1. Set the number of operation data that you want to execute in “Operation data #.”
2. Click [Start positioning operation].

3. Click [Yes]. The positioning operation with the selected operation data number starts.

Click [Stop] to stop the operation before completion.
## Return-to-home operation

1. Click [Home operation].
2. Click [Yes].
   The return-to-home operation starts.

   ![Return-to-home operation](image)

Click [Stop] to stop the operation before completion.

## ZHOME operation

You can perform return-to-mechanical home (ZHOME) operation.

1. Click [ZHOME operation].
2. Click [Yes].
   The ZHOME operation starts.

   ![ZHOME operation](image)

Click [Stop] to stop the operation before completion.

## JOG operation

You can operate the motor either continuously or in steps of the specified minimum distance.

The method of JOG operation varies depending on the product.

JOG operation can be executed using the following buttons. The JOG operating speed can be changed using a parameter.

![JOG operation buttons](image)

- : Moves the motor in the negative direction at the JOG operating speed.
- : Moves in the negative direction at the speed of one-tenth of the JOG operating speed.
- : Moves the motor in the negative direction by the minimum distance.
- : Stops the operation immediately.
- : Moves the motor in the positive direction by the minimum distance.
- : Moves in the positive direction at the speed of one-tenth of the JOG operating speed.
- : Moves the motor in the positive direction at the JOG operating speed.
## Teaching

While operating the motor, you can set the current motor position as the operation data.

1. Change the current motor position either manually or with JOG operation. Do so while checking the "Command position (CPOS)" in "Driver status." Use the JOG operation buttons to move the motor with JOG operation.

2. Select an operation data number at "Operation data #" in "Teaching."

3. Select an operation mode and click [Position set]. If you select "No setting for operation mode," the operation mode set in the operation data number is used. The new position information is set to the selected operation data number.

4. Click [Reflecting on the driver] to set the teaching data to the applicable product.

5. Click [Yes]. The data is written to the applicable product.

---

**Note**

Just clicking [Position set] will not cause to write to the applicable product. Be sure to execute [Reflecting on the driver].

**memo**

While the applicable product and PC are connected (online), you cannot edit data other than the operation mode and position. Edit these data under disconnected condition (offline).
12-2 Teaching software limit

While operating the motor, you can set the current motor position as the software limit value.

1. Enable the teaching/remote operation.

2. Change the current motor position either manually or with JOG operation. Do so while checking the "Command position (CPOS)" in "Driver status." Use the JOG operation buttons to move the motor with JOG operation.

3. Click [Preset (CPOS−1)] to set a software limit value in the negative direction. Click [Preset (CPOS+1)] to set a software limit value in the positive direction.

4. Click [Yes]. The software limit value is set. When [Preset (CPOS+1)] is selected, the positive software limit value is the command position +1. When [Preset (CPOS−1)] is selected, the negative software limit value is the command position −1.

5. Click [Reflecting on the driver] and then [Yes]. The data is written to the applicable product.

Note: Just clicking [Preset (CPOS−1)] or [Preset (CPOS+1)] will not cause to write to the applicable product. Be sure to execute [Reflecting on the driver].
12-3 Utilizing waveform monitor

Refer to p.40 for the basic usage procedure of the waveform monitor. As examples of utilization of the waveform monitor, this section explains the following items using screens of the AZ Series Pulse input type and Built-in controller type.
- Zooming in on waveform data
- Moving drawing positions of waveforms for multiple CHs simultaneously
- Saving waveform measurement results as images
- Saving waveform measurement results as data

■ Zooming in on waveform data

You can enlarge and display part of the measured waveform data. The following shows an example of zooming in on around the peak value after measuring the detection speed of CH1.

1. Measure the waveform.
   In this example, the detection speed of CH1 is measured.

2. Select “CH1” in "Measure," and select the ΔV check box.
   The result shows the peak value of CH1 at around 300 r/min.

3. Click [CH settings].
   The CH settings window appears.
4. In "Offset" of CH1, enter a center value onto which you want to zoom in.
In this example, enter 300 (r/min), the measurement result of Step 2, to zoom in on around the peak value.

5. Change "Scale" of CH1.
In this example, set the speed for each scale on the vertical axis.

The waveform is zoomed in, centering on the value entered as the offset value.

### Moving drawing positions of waveforms simultaneously

You can change the display positions by moving the waveform curves in the window.
This section explains how to move multiple CH curves simultaneously.

1. After waveform measurement, click the button located in the upper right corner of the waveform monitor window.
   The button is changed to .

2. Click the CHs that you want to move simultaneously.
   When you want to move all of the lines on the waveform simultaneously, click .
   All of the CHs can be selected.

3. Drag the waveform curves in the window to move them vertically.
   The selected CHs are moved simultaneously.
**Saving setting conditions for measurement**

The setting for measurement can be saved as "Favorites data."

1. In the waveform monitor window, click [Save favorites data].

2. Enter a data name and click [Save].
   You can also enter a memo in the comment field.

**Loading saved setting conditions**

The setting for measurement can be loaded from "Favorites data."

1. In the waveform monitor window, click [Load favorites data].

2. Select data that you want to load and click [Open].
   The loaded setting conditions are applied to the waveform monitor window.

**Saving waveform measurement results as images**

The currently displayed waveform can be saved as a bitmap-format image.

1. In the waveform monitor window, click [Save waveform data].

2. Enter a file name, set the file type to the bitmap format (*.bmp), and click [Save].
   The waveform is saved in the bitmap format.
### Saving waveform measurement results in CSV format

The currently displayed waveform can be saved in the CSV format.

1. In the waveform monitor window, click [Save waveform data].

2. Enter a file name, set the file type to the CSV format (*.csv), and click [Save]. The waveform is saved in the CSV format.

### 12-4 Checking wiring of applicable product

Using I/O test, you can monitor input signals and cause output signals to be output forcibly. This function is convenient if you want to check the wiring of I/O signals and the operation of network I/O.

**Note** In I/O test, you can forcibly turn on or off output signals. Consequently, other equipment connected to an applicable product may operate. Check the surrounding circumstances to ensure safety before conducting this procedure.

**memo** The teaching/remote operation and I/O test cannot be executed simultaneously.

1. Click the [Test I/O] icon in the toolbar or click the [Test I/O] short-cut button. The test I/O window appears.
2. Click "Start I/O test."
3. Click [Yes]. I/O test is enabled.
4. Switch the ON/OFF status of input signals externally. The check box of the corresponding "INPUT" is changed in the window.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direct I/O</th>
<th>Remote I/O (RS-485 communication)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON(green)</td>
<td>Conducting</td>
<td>Active</td>
</tr>
<tr>
<td>OFF(white)</td>
<td>Non-conducting</td>
<td>Not active</td>
</tr>
</tbody>
</table>
5. When switching the ON/OFF status of output signals, click the check box \( \square \) of "OUTPUT" in the window.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direct I/O</th>
<th>Remote I/O (RS-485 communication)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON(green)</td>
<td>Conducting</td>
<td>Active</td>
</tr>
<tr>
<td>OFF(white)</td>
<td>Non-conducting</td>
<td>Not active</td>
</tr>
</tbody>
</table>

6. To exit I/O test, unselect "Start I/O test."

12-5 Utilizing the warning function for when writing data

This function can be used only for the product that a desired name (user name) can be set to the motor or driver. When writing the MEXE02 data to the applicable product, setting the user name can prevent from overwriting the data to a wrong product.

This section explains using screen examples of the AZ Series Pulse input type and Built-in controller type.

2. Select the user name to be compared from "Warning for writing data," and click [OK].

## When writing data

When writing data, if the user name is not same between the MEXE02 and applicable product, the following message is displayed.

Click either [Yes] of [No] after checking the applicable product.
[Yes]: Writing data will be executed.
[No]: Writing data will be discontinued.
12-6 Updating the firmware of applicable product

The firmware of the applicable products can be updated using the MEXE02. This section explains how to update using windows/screens of the AZ Series pulse input type, the built-in controller type, and the pulse input type with RS-485 communication interface.

memo
- The update of firmware can be executed for the applicable products that [Firmware update] is shown under the [Support] menu.
- Stop the motor before starting the update of firmware.
- Check on the Oriental Motor Website for the latest firmware version of applicable products.

1. Click on [AZ driver firmware update] from the [Support] menu.

2. Click [OK].

3. Click [Yes].
   Updating the firmware starts.

memo
- Do not turn off the power of the applicable product until the update of firmware is completed.
- Once the update of firmware is executed, the version cannot be returned to the previous one.
- If the firmware of the applicable product has already been updated, the following dialog box is shown.

4. After it is completed, click [OK].

The firmware version of the applicable product can be checked with the unit information monitor.

memo
Even if the firmware is updated, the settings for the operation data and parameters before updating have been retained.
13-1 Checking error message

If the MEXE02 has encountered a problem while running, a corresponding error message is shown in the window. "Measures" may be displayed depending on the contents of the error message. Click "Measures" to display the error details. Check the screen and appropriately deal with the issue.
13-2 Frequently encountered errors

This section explains frequently encountered errors and measures required for them.

- Communication fails

During data reading, writing, monitoring and testing, the following error message may be displayed, and communication may not start.

Example: When reading data

![Error message]

The problem may be resolved if you specify the settings in the procedure shown below.

1. Click [Option] from the [Tool] menu. The "Option" dialog appears.

2. Click "When a motor stops without intending during motor driving, please check it." and then click [OK].
Troubleshooting

If the problem persists after you take the procedure above, the cause may be one of the following. Take an appropriate measure.

<table>
<thead>
<tr>
<th>Cause</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Other applications are running</td>
<td>Exit the applications other than the MEXE02 before continuing the operation.</td>
</tr>
<tr>
<td>2. Too many applications stay resident</td>
<td>Exit the resident applications before continuing the operation. For some types of applications, exiting them may not resolve problems. In this case, use a PC on which the relevant applications are not installed.</td>
</tr>
</tbody>
</table>
| 3. The processing speed of PC is insufficient | • Take the measures 1 and 2 above.  
• Refer to p.6 and check that your PC satisfies the system requirements. |

### Communication timeout error occurs

If communication is not possible even when the applicable product is powered on and a correct communication port is selected, perform the following procedure.


2. Click "When communication time-out errors are frequent, please check it." and then click [OK].
**Troubleshooting**

- **Other window is communicating**

  At the start of monitor or test, the following error message may be displayed, and communication may not start.

  **Example: Performing waveform monitor**

  Other data setting window may be executing the communication function. While one window is executing the communication function, other windows cannot use it. Check this point using the following procedure:

  1. Click the [Window] menu. A list of currently open windows is displayed.

  2. Select another window to check if it is online. If it is, click the [Offline] icon in the toolbar to clear the communication.

- **Editing cannot perform in communication**

  When editing data, the following error message may be displayed.

  You cannot edit data while the communication function is executed. Click the [Offline] icon in the toolbar to clear the communication. Data can be edited.